
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Meet XL 
XL Version 2.18 

Audience:  This guide is for anyone that wants to get a 

deeper understanding of the XL platform.  

 

Purpose:  Introduces you to XL and provides a top-level 

view of key features.  
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How to Contact Us 
Need help? Contact us from 8:00 AM to 6:00 PM Monday to Friday CST (UTC-6:00). 

Call:  +1.630.875.3600 

Fax: +1.630.875.3609 

Email: sales@vorne.com, support@vorne.com 

Mail: 1445 Industrial Drive, Itasca, IL 60143, USA 

 

We also have an extensive network of international partners. View them at www.vorne.com/partners.   

Important User Information 
XL products are not designed or intended for control applications and MUST NOT be used for control 

applications under any circumstances. There are fundamental differences in the design methodology of a 

control product such as a Programmable Logic Controller (PLC) and a non-control product such as an XL 

device. Outputs (e.g., relays) are provided for annunciation only, and MUST NOT be used for control purposes. 

This product is designed and intended for use solely in indoor industrial applications and MUST be installed by 

a qualified electrician. This product is designed and intended for use solely in a secure, private network 

environment. It is the responsibility of all persons applying this product to a given installation and/or 

application to carefully review the installation and/or application to evaluate and ensure the suitability of this 

product for the intended application. 

This documentation, including any examples, diagrams, and drawings, is intended to provide information for 

illustrative purposes only. Because of the differences and varying requirements of different installations and 

applications, Vorne Industries, Inc. cannot assume responsibility or liability for actual use, including use based 

on any examples, diagrams, and drawings. 

In no event will Vorne Industries, Inc. be responsible or liable for indirect or consequential damages resulting 

from the use or application of this product. Please carefully review the Vorne Product Warranty Statement 

at www.vorne.com/warranty.htm and the Vorne Sales Terms and Conditions at www.vorne.com/terms.htm. 

Vorne Industries, Inc. makes no warranties express or implied except as expressly stipulated in our Product 

Warranty Statement. 

While the information in this document has been carefully reviewed for accuracy, Vorne Industries, Inc. 

assumes no liability for any errors or omissions in the information. Vorne Industries, Inc. reserves the right to 

make changes without further notice to any products described in this documentation. 

Important Legal Notice: US Patent US9100248, US9633135, US9864961, US10909480, EP Patents 

EP2145452, EP2381649, Canadian Patents CA2686313, CA2786004, Mexican Patents MX354053, MX381115, 

China Patents ZL201810151892.3. Additional patents pending. Copyright © 2023 Vorne Industries, Inc. Vorne, 

XL and other Vorne Industries, Inc. trademarks described herein are the exclusive property of Vorne 

Industries, Inc. All other trademarks are the property of their respective owners. This product and its 

associated software and documentation (collectively “the Product”) contains Vorne Industries, Inc. proprietary 

material, and is further protected by statute and applicable international treaties. The Product may not be 

reverse engineered or used in any manner for competitive purposes without the prior express written consent 

of Vorne Industries, Inc. Any rights not expressly granted herein are reserved.  

mailto:Support@vorne.com
https://www.vorne.com/support/technical-support/book-meeting/
mailto:sales@vorne.com
mailto:support@vorne.com
http://www.vorne.com/partners
https://www.vorne.com/warranty.htm
https://www.vorne.com/terms.htm
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XL Platform 
XL is a productivity improvement platform with over 25,000 XL devices installed across 45 countries.  

We pride ourselves on the ease of our platform and a simple, cost-efficient implementation.  Start small 

with a single unit on a 90-day free trial.  If XL works for you, expand to a department, then site, then entire 

enterprise.  Your upfront commitment is minimal, and expansion is on your timeframe – not ours.  

As you add more XL devices, they communicate with each other using our patented technology to 

provide you with complete information and integrated reporting. You can also connect XL devices to XL 

Enterprise cloud services for an even more integrated experience.  

Summarized in the sections below, the XL Platform consists of three parts:  

• XL Productivity Appliance™ 

• XL Enterprise™ 

• XL Integration Tools 

XL Productivity Appliance 
The XL Productivity Appliance (XL810, XL610, XL410, or the XL HD) is an IoT device that monitors a 

single manufacturing process. XL devices are unique because they work equally well as stand-alone devices, 

networked devices in your internal network, or edge computing devices connected to XL Enterprise. Every 

XL Productivity Appliance™ includes the following features:  

 

The production monitor snaps onto your existing manufacturing process with just one or 

two sensors. From this simple integration, XL generates 120 metrics (numeric values) and 
20 dimensions (descriptive values). More importantly, it delivers a comprehensive view of 
production and productivity.  

 

The data warehouse stores the production data XL collects in a SQL database and makes 

that information available to you via reports, dashboards, export templates and the XL API. 
One of the paramount XL design goals is to always make the underlying data easily 
accessible and immediately available to you and your team. 

 

The scoreboard provides instant feedback for your plant floor team so they can “win the 

shift”. The only difference between XL models is the scoreboard. Every XL collects the same 
in-depth information and provides the same in-depth reporting.  

 

The reports engine provides instant access to over 50 built-in reports organized as pages 
and views. Views can be built-in (shipped with the device), shared (created by a user and 
shared with others), or local (created for personal use).  

 

The dashboards engine enables you to create an unlimited number of custom reports. 

Combine chart, table, chronogram, KPI, and KPI group widgets in dashboards to create 
your own reports. Dashboards can also roll up data from multiple XL devices.    

 

The settings menu allows you to configure and adapts XL to your application. The nuts 

and bolts of this console are covered in the Configure XL Guide. 

 

  

mailto:Support@vorne.com
https://www.vorne.com/support/technical-support/book-meeting/
https://www.vorne.com/support/product-manuals/configure-xl.pdf
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XL Enterprise 
XL Enterprise, a separate SaaS (Software as a Service) application developed by Vorne that runs on 

Amazon Web Services, provides optional free and paid cloud-based services that extend the functionality 

of XL. XL Enterprise currently provides three free services: 

 

Alerts: monitors production in real-time to deliver email and text messages that help your 
team drive action when it’s needed – right away. Create alerts based on metrics (e.g., OEE 

below 75%), production states (e.g., down more than 15 minutes), and targets (e.g., 
changeover 5 minutes over target time). Automatically escalate as the severity of the 
situation increases.  

 

Reports: emails you production reports at the end of each shift. Select from built-in 

templates with options to customize.  Templates can focus on a single work center or 
aggregate information from multiple work centers.  

 

Updates: makes it easy to take advantage of new features released for the XL Productivity 
Appliance™. Each time a new software update is available, the XL Productivity Appliance 
automatically downloads it – ready to be applied at a time of your choosing. 

XL Integration Tools  
XL Integration Tools make it easy for you to integrate XL with your other systems and applications. The 

XL platform includes built-in tools, the XL API for programmatic integrations, and third-party tools to help 

you create specialized integrations and customizations unique to you. Our recommendation is to start 

simple and add integrations once XL is firmly established and adding value to your day-to-day operations. 

When you are ready, there are three types of integrations: 

 

Built-in tools enable XL to use information from your existing systems with minimal 

investment of time or money. For example, XL can be configured to respond to your existing 
part and job barcodes, and you can import parts and jobs using simple spreadsheets. Built-
in integrations are particularly useful for smaller companies with limited IT resources.  

 

The XL API is a REST-based interface that enables you to directly integrate XL with other 

systems and applications (e.g., ERP applications). The XL API is particularly useful for larger 
companies with well-staffed IT departments that want total control over integration projects. 

 

Third-party tools are products and services offered by partner companies. Examples 
include PLC integration, ERP integration, and local SQL databases to integrate to your 

enterprise reporting platform. This is a great choice for any company that wants to leverage 
standard products to accelerate progress. Learn more about third-party tools at 
www.vorne.com/tools. 

 

 

XL is continually improving – with new features released every few months. To see the latest 
features, visit www.vorne.com/new. 

Our team is here to help.  Please contact us with any questions.  

TIP 

mailto:Support@vorne.com
https://www.vorne.com/support/technical-support/book-meeting/
http://www.vorne.com/new
https://www.vorne.com/products/integration-tools/
http://www.vorne.com/new
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How XL Categorizes Time 
XL assigns every moment of time to an impact value, production state, and reason; impact directly 

affects how metrics are calculated. This provides a consistent way to view information, perform 

analytics, and generate reports. Time categorization starts with a reason which can be added by users.     
 

Impact Production States Reason (Examples) Metrics 

 

 

Run 

Running Running Normally 

Affects OEE, TEEP, Target Count, 

and Labor metrics via 

Performance and Quality Loss 

Running Slow Slow and/or Small Stops 

Running Poor 

Quality 
Running Poor Quality 

Running Poorly Slow with Poor Quality 

 

Unplanned 

Stop 
Down 

Missing Reason, Breakdown, Jam, 

No Material, No Operator  

Affects OEE, TEEP, Target Count, 

and Labor metrics via Availability 

Loss 

 

Planned 

Stop 

Changeover Changeover, Part Change 
Affects OEE, TEEP, and Labor 

metrics via Availability Loss 
Maintenance Cleaning, 5S, General Maintenance 

 

 

 

Not 

Scheduled 

Meal/Break Break, Lunch 

Affects TEEP metrics via Schedule 

Loss 

Meeting Shift Handover 

No Production 
Optional Shift Scheduled, Shift 
Ended Early 

Not Monitored Powered Off, Upgrading 

 

Impact provides a top-level perspective aligned with how time affects productivity metrics.  

Production State provides a standardized and uniform way for XL to describe what is happening at the 

manufacturing process from a "best practices" perspective. This standardization enables consistent 

reporting and seamless integration with third-party tools.  

Reason describes time from your perspective – using terms that are familiar to your company. Reasons 

are particularly valuable for capturing information with a greater level of detail – enough detail to help 

you address losses and drive improvement. You can define an unlimited number of reasons. Reasons can 

be provided by XL (e.g., Running Normally), by operators (e.g., No Material), or by integrations (e.g., 

from a PLC). 

  

mailto:Support@vorne.com
https://www.vorne.com/support/technical-support/book-meeting/
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Metrics and Dimensions  
XL organizes production data as either a metric or dimension.  

▪ Metrics are numeric values that measure a quantitative characteristic of production, such as Good 

Count, OEE, or Labor Efficiency.  

▪ Dimensions are descriptive values that refer to a qualitative attribute of production, such as the 

Shift, Work Center, or Hour. 

 
For a complete list of metrics and dimensions with descriptions refer to Appendix A and Appendix B.  

 

How XL Aligns Time  

XL aligns time-based dimensions with your shift schedule to make reports more consistent and easier to 

understand, especially across work centers. 

Weeks are captured as production weeks. Production weeks always run from Monday to Sunday to 

provide consistency when aggregating information across multiple time zones and geographical areas. 

Days are captured as production days. Production days are based on shift boundaries to ensure that 

shifts that cross midnight don’t get split across two days in reports. You can configure XL to begin your 

production day with the last shift before midnight or the first shift after midnight. You can visually see 

this in the time schedule, which shows each shift within its associated production day.  

Shifts are captured as shift and ordinal shift. Both of these reference the exact same periods of time. 

Shift uses the names you configure for each shift (e.g., Shift 1 or AM Shift). Ordinal shift is automatically 

assigned by XL and represents the order of shifts within a production day (e.g., 1st Shift of Day). Ordinal 

shift makes it much easier to align shifts across work centers in reports. 

Hours are captured as shift hours (e.g., Shift Hour 1, Shift Hour 2). Shift hours are relative to the 

beginning of the shift. For example, the first hour of each shift is Shift Hour 1. This makes it easy to 

compare information across shifts (such as that all-important first hour, which often makes or breaks a 

given shift). It also makes it easier to align data across time zones since even with different start times 

shifts can be compared hour-by-hour.  

  

mailto:Support@vorne.com
https://www.vorne.com/support/technical-support/book-meeting/
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Run Detection and Cycles 
XL Automatic Run Detection continually monitors and analyzes the cycle input to determine if the 

manufacturing process is running or down and if it is running, how well is it running (i.e., what are the 

losses from slow cycles and small stops). If this is a poor fit for your application (e.g. your process does 

not create cycles, or your cycle times span multiple hours), use the Deploy XL: Manual Run Detection 

guide for more information. 

There are three configurable thresholds found in Settings > Plant Floor > Parts and Run States  

Threshold Default Description 

Ideal Cycle 

Time 

1.0 second The theoretical fastest possible cycle time. Set for each part. It is extremely important that this 

value be accurately set as it is used to calculate OEE Performance. Refer to the Collect 

Accurate Data chapter for more information. (Found in Parts) 

Small Stop 500% of ICT Differentiates between run cycles and small stops. One value applies to all parts. Set as a 

percentage of Ideal Cycle Time. (Found in Run States) 

Down 3 minutes Differentiates between small stops and down. Set for each part. Note that this threshold, as well 

as the small stop threshold, does not affect your overall OEE score. Instead they merely change 

the type of cycle loss and the balance between cycle loss (OEE Performance) and down time loss 

(OEE Availability). (Found in Parts) 

 

XL can also monitor and analyze the cycle input to detect transitions from one production state to 

another. This can be configured to be as simple as detecting cycles or as complex as having to maintain a 

configurable speed for a configurable number of cycles.  

Threshold Default Description 

Running After 1 cycle The Running setting used by XL to automatically detect when the process transitions 

from down to running. When this threshold is met you should be reasonably 

confident the process is running.  

Definitely 

Running 

When avg. speed is 50% 

of ICT across 10 cycles 

The Definitely Running setting is used for features like automatically exiting 

changeovers or detecting when a shift has started early. When this threshold is met 

you should be very confident that the process is running.  

Ideal Cycle Time vs. Takt Time 
It is important to understand the difference between Ideal Cycle Time and Takt Time. Both represent the 

duration for one cycle and are set per part, but they have vastly different purposes. 

Value Drives Description 

Ideal Cycle Time OEE Performance The theoretical fastest possible time to complete one manufacturing cycle. 

Includes no “budgeted” losses whatsoever.  

Takt Time Target Count & 

Efficiency 

The expected time to complete one manufacturing cycle. Includes “budgeted” 

losses for down time, small stops, slow cycles, and rejects.  

Once Takt Time is correctly set per part, it applies every time that part is run and 

an Efficiency of 100% or better represents a “Win” for your team.  

 

The easiest way to calculate Takt Time is to think of your expected rate per minute or rate per hour and 

use the built-in calculators to help convert this to a time per cycle. 

  

 

mailto:Support@vorne.com
https://www.vorne.com/support/technical-support/book-meeting/
https://www.vorne.com/support/deploy-xl-manual-run-detection.pdf
https://www.vorne.com/solutions/takt-time.htm
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Data Warehouse 
Each XL device stores the production data it collects in its own embedded database. This means that 

there is no requirement for you to install a dedicated server or SQL database.  

One of the paramount XL design goals is to always make the underlying data easily accessible and 

immediately available to you and your team. The data warehouse supports this by providing many ways 

for you to access your data.  

Access Method  Description 

Reports XL includes a sophisticated reporting engine, which runs in your browser, and includes over 50 built-in 

reports organized as pages and views. Many of the reports are configurable on-the-fly with controls for 

exploring your data. 

Dashboards It is easy to create custom reports using point-and-click tools included in every XL. Use widgets (andon, 

chart, chronogram, event list, KPI, KPI group, pivot table, table, and top losses) to organize information 

in whatever way is most helpful to you and your team. 

Export Templates Create any number of Excel® export file templates (another dashboards feature). Each export template 

includes the metrics and dimensions that you select organized as tabular data – ready to export as an 

Excel® file. 

XL API Use our REST API to programmatically access information from XL devices. You can access raw “table” 

data as well as business-ready “channel” data. Please note that the XL API is subject to change as we 

continue to add to and improve the XL platform. 

Backup You can instantly create a backup of your production data with a single click from the XL browser 

interface (Settings > Management > Backup and Restore). 

Scoreboard  
The scoreboard always reflects the current state of your manufacturing process. It provides your 

operators with contextual information that guides their actions towards “winning the shift”.  

 

The run screen is displayed when running normally.  The default screen 
shows TAED (Target, Actual, Efficiency, Down) so your operators can 

easily see what they have produced and if they are winning the shift 

(Efficiency ≥ 100%). If you prefer different metrics, the run screen can be 
configured (Settings > Device > Scoreboard). 

 

If the line goes down, your operators are immediately prompted with a 

message that includes event down time and a reminder to scan a Down 
Reason. Note: the Reason can be scanned any time before the next down 
event. 

 

If Run Variants are enabled, when running slow, running poor 

quality, or running poorly (which is running slow with poor quality), 
your operators will be prompted in real-time so they can respond 
immediately. 

 

When a changeover, maintenance, meal/break or meeting starts, 
your operators are prompted with a target and remaining time (if so 
configured) to help them stay on target. 

mailto:Support@vorne.com
https://www.vorne.com/support/technical-support/book-meeting/
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Reports 
XL includes over 50 built-in standard reports organized as pages and views: 

▪ Each Page presents information with a different layout and visual design. (see summary below) 

▪ Each View captures a different perspective on a page using the controls for that page.  For example, 

the All Production page rolls up metrics across your work center hierarchy and includes 17 built-in 

views, such as Production Overview, Cycle Time Audit, OEE Factors, and Hidden Factory.   

Built-in report pages are featured in Appendix C and summarized below. 

Report Page Description 

Advanced Analytics Dynamically explore data through an interactive set of KPI, chart and table widgets. Includes 17 

built-in views. 

All Production View rolled-up real-time and historical production data for every work center, area, and site. 

Includes 17 built-in views.  

Andon View the real-time status of every process with a colorful page suitable for display on a large 

format television or monitor. Includes 6 built-in views. 

Changeover Deep dive into changeovers with instant analytics and answers to key questions. 

Down Time Deep dive into down time and its underlying reasons.  

OEE Deep dive into OEE and its underlying factors: availability, performance, and quality.  

Performance Loss Deep dive into performance loss and its underlying constituents: cycle loss and small stop loss.  

Quality Loss Deep dive into quality loss and its underlying constituents: startup rejects and production rejects. 

Six Big Losses Deep dive into the six big losses: down time, planned stops, cycle loss, small stops, startup rejects, 

and production rejects. 

Teams and Labor Deep dive into teams (an analytical dimension) and labor (metrics). 

TEEP (Hidden Factory) Deep dive into TEEP, which fully exposes your “hidden factory” by extending OEE with utilization 

and schedule loss.   

Timeline View the state of multiple work centers over time on a synchronized timeline. Includes 6 built-in 

views.  

Top Losses View every loss that impacts OEE, ranked and prioritized by how much production time was lost, 

with additional details for each loss.  

Total Production Timeline View the state of the manufacturing process over time, including production state, shift hours, 

shifts, and part runs. 

View Comments Analyze comments to identify follow up and improvement actions – or simply to verify that your 

team is following your policies for capturing comments. 

Dashboards 
In addition to built-in views, XL includes a powerful engine for custom reporting via Dashboards.  Each 

Dashboard starts as a blank page, allowing you to add any widget combinations and control the 

dashboard layout. All dashboard widgets are enterprise-aware, so every widget can include data from 

one or more Work Centers in your hierarchy. 

Dashboards are also where you create data export templates. Simply create a table with the desired 

dimensions and metrics, and XL automatically provides an option to export it as an Excel® spreadsheet. 

See Appendix D for step-by-step instructions to create custom Dashboards. 
 

mailto:Support@vorne.com
https://www.vorne.com/support/technical-support/book-meeting/
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Overview 
XL Enterprise™ is a cloud application that provides free and paid services that extend the functionality 

of XL Productivity Appliance. None of the services are required. XL can fully function without XL 

Enterprise. Free services include:  

▪ Alerts (real-time email alerts for conditions you configure).  

▪ Email Report Templates (automatically delivered reports at the end of each shift). 

▪ Enterprise Hierarchy (central management of the asset hierarchy across multiple devices). 

▪ Updates (software updates delivered directly to XL devices and installed at your convenience). 

Refer to the Configure XL guide for information on how to link XL devices to XL Enterprise.  

 

XL Enterprise receives real-time production information from your XL devices. However, it does 
not store this production data for any extended period. Once the alert or report is sent, the 
associated data is automatically deleted from XL Enterprise. 

IT NOTE 

Alerts 
The alerts service monitors production in real-time and delivers notifications to your team to help you 

drive immediate action. There are three types of alerts: 

Alert Type   Description Example 

Metric Monitor normalized metrics such as Efficiency and OEE for the current shift. A 
typical application is to be alerted if your team is not on track to win the shift.  

Efficiency < 95% 

Production State Monitor duration of production state events. A typical application is to be alerted 

to long down events.  

Down > 15 minutes 

Target Compare duration of an event to its target. A typical application is to be alerted 

to changeovers that take longer than expected.  

Changeover 5 minutes 

over target  

 
Setting up Alerts in XL Enterprise is easy: 

▪ Admins define Alerts that apply to every linked XL Device in the organization (these are subject to 

User access level limitations). 

▪ Admins create Users and assign them access to applicable levels of the Organization Hierarchy. 

▪ Users subscribe to the Alerts and Work Centers that are most relevant to their area of responsibility.  

 

 

 

 

We recommend starting with a small number of alerts that represent critical scenarios where 
attention is clearly needed. Otherwise, alerts can quickly become “noise” that is ignored.  

TIP 

mailto:Support@vorne.com
https://www.vorne.com/support/technical-support/book-meeting/
https://www.vorne.com/support/product-manuals/configure-xl.pdf
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Email Report Templates 
XL Enterprise can automatically email you production reports at the end of each shift. You can select 

from built-in templates, or you can create your own. Templates can focus on a single work center or 

aggregate information from multiple work centers. 

 

Built-In Views include: Availability Loss Detail, End-of-Shift Report, Part Rate Summary, and Plant Shift 

Overview 

Custom XL Enterprise Reports 
XL Enterprise allows select customization of reports sent at the end of each shift.  This flexible platform, 

similar to the Dashboards feature in XL, leverages KPI, KPI Group, and Table Widgets for nearly unlimited 

data delivery to your doorstep. 

 

mailto:Support@vorne.com
https://www.vorne.com/support/technical-support/book-meeting/
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Overview 
While fully functional and valuable on its own, the XL platform offers a wide range of Integration Tools 

to meet your data integration needs with external systems.  

Built-In 
Built-in integration tools use information from other systems without having to establish direct 

connections to those systems. They are particularly useful for smaller companies with limited IT 

resources. Built-in integration tools include: 

▪ Part Lookup: If your product packaging or work order includes a barcode representing the unique 

part, XL can be configured to automatically start a part run when that barcode is scanned.  

▪ Job Lookup: Alternately, if your work order includes a job barcode generated by your ERP/MES 

system, XL can be configured to automatically start that job when that barcode is scanned OR to 

simply add that job ID to the currently running part run.  

▪ Import Parts and Jobs: It’s simple to export parts or jobs from XL as a spreadsheet, make any 

desired updates, and then import the updated parts or jobs back into XL.  

XL API 
The XL API is a REST-based interface that enables you to directly integrate XL with other systems and 

applications. You can use this API to push information to XL (e.g., job parameters) or to retrieve 

information from XL (e.g., job metrics). The XL API can also be used to encode information into 2D 

barcodes that can be scanned to start jobs with information directly generated by your ERP/MES system.  

The XL API is particularly useful for larger companies with well-staffed IT departments that have the 

resources to create and maintain custom integrations. The XL API guide provides detailed instructions on 

how to programmatically interact with XL. Please note that the XL API is subject to change as we 

continue to add to and improve the XL platform.  

To learn more about the XL API, contact support@vorne.com  

Third-Party 
Third-party integration tools are products and services offered by partner companies. This is a great 

choice for any company that wants to leverage standard products to achieve fast progress and avoid 

maintaining custom IT projects. Examples of third-party tools include: 

▪ Data Collector: Automatically harvest data from multiple XL devices into an SQL database. 

▪ Data Link ERP: Transmit production standards from your ERP system to XL, and transfer production 

data for completed shifts and jobs from XL to your ERP system. 

▪ Data Link PLC: Transmit information from PLCs to XL devices (e.g., down reasons). 

▪ PiXL: Display custom graphics or messages on the XL scoreboard based on various triggers. 

To learn more about third-party tools visit www.vorne.com/tools. 

 

We recommend implementing integrations between XL and other systems once XL is firmly 
established and adding value to your day-to-day operations (i.e., collecting high-quality data and 
using that data to drive improvement). Otherwise, it is far too easy to get hung up on technical 
projects and lose sight of how much you can accomplish with XL right out of the box.  

TIP 
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Overview 
Each XL device monitors one manufacturing process. We recommend starting with a single sensor (see 

Get Started) and refining your installation over time with additional sensors (see Track Quality and 

Focus on the Constraint). A single sensor is EASY and still generates a huge amount of actionable 

information, including detailed information about down events, changeovers (OEE Availability), cycle 

losses and small stops (OEE Performance). And the benefit is you get started quickly.  

Get Started  
You only need four things: 

 

In Count Sensor – A single sensor that XL uses to calculate counts and track cycles. Take 
this input from wherever it is easiest to access a signal that represents the cyclical flow of 

parts. If each cycle produces multiple parts XL can apply a count multiplier (Settings > 

Parts and Run States > Parts).  

 

2D Barcode Scanner – The operator typically uses a 2D barcode scanner to start new part 

runs and to tag reasons on down events automatically detected by XL. If desired, the 
operator can use the 2D barcode scanner to start jobs (instead of parts), changeovers 

(instead of changeovers automatically starting with part runs), and breaks (instead of using 

the time schedule), etc. 

 

Ethernet – Connect XL to your network and use a browser to configure XL and to access its 

powerful integrated reporting capabilities (including rollup of metrics across multiple 
devices). 

 

Power – The scoreboard is powered off mains voltage (100 to 240 VAC) so you will need 

power where you plan to hang the scoreboard.    

 

Track Quality 
Once you are collecting data and using that data to drive improvement actions, the logical next step is to 

collect quality information (OEE Quality). You can add a Reject Count or Good Count sensor or alternately 

you can use a 2D barcode scanner to enter reject counts with reasons. Either way, your OEE score will 

now be complete with the addition of OEE Quality.  

Focus on the Constraint 
If you are monitoring a manufacturing process with multiple steps, it is a best practice to measure down 

time and cycle losses from the perspective of the constraint. To do so, bring a dedicated cycle input to XL 

from the constraint step of the line.  

For an in-depth review of different installation scenarios refer to the Install XL guide. 
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Overview 
Establishing an accurate data foundation is essential to making effective decisions. This chapter provides 

tips on how to collect accurate data – based on real-world experience across thousands of applications.  

Start Simple and Iterate 
One of the biggest mistakes companies make when deploying any kind of system is adding complexity 

that reduces adoption by users. So, we recommend starting with a simple deployment and iterating over 

time to add more detail to the data you collect with XL. Here are tips to help you simplify your initial 

deployment, while still collecting highly accurate and actionable data.  

Setting  Recommendation 

Inputs Start by measuring only In Count, preferably at the process constraint. Just this one input will generate 

a huge amount of actionable information. 

Down Threshold Set down thresholds that create no more than 25 down events per shift. This makes it much easier to 

train operators to scan a reason for EVERY down event. 

Down Reasons Create no more than 25 down reasons (it is easy to add more later). Spend time carefully naming and 

organizing reasons to make it easy for operators to select and scan the right reason. 

Parts If you have more than 50 parts, either group them into product families to give operators fewer barcodes 

to scan (see Group Parts into Product Families below) or use built-in integration tools to enable 

operators to scan existing part barcodes (see the XL Integration Tools chapter). 

Scoreboard Configure the scoreboard to show metrics that are meaningful to operators. For example, Efficiency is 

more intuitive than OEE. We recommend TAED (see Set Clear Targets in the next chapter). 

Confirm and Validate Ideal Cycle Times 
Having an accurate ideal cycle time (ICT) for each part is essential for generating a meaningful OEE 

score. ICT is the theoretical fastest possible cycle time for the part. It represents perfect production – no 

cycle losses at all. Many companies base their ICTs on a budget or standard time that is significantly 

higher (slower) than it should be. This hides production losses and artificially inflates OEE.  

 

To quickly identify if your ICTs are correct, navigate to the Reports Menu > Analyze > Performance 

Loss page. Look at the chart titled “Am I running close to my ideal cycle time?” If any of the left (blue) 

bars are taller than the right (green) bars – the ICT for that part is set too high (slow). 
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Hide Erroneous Information 
When starting with XL it’s common to collect some erroneous data as configuration is refined and 

operators are trained. We recommend that you clear early data so that it doesn’t affect your reports. 

1. Log in as Administrator. 

2. Navigate to Settings > Management > Modify Data. 

3. Click on the Clear Data tab. 

4. Use the Time Range control in the upper right of the page to select the appropriate time period. 

5. Use the dropdown to select the granularity of data to clear (typically Shift or Production Day). 

6. Place a checkmark next to each interval to be cleared. 

7. Click the Clear Data button at the bottom of the page.  
 

 

Regularly Review Data Quality Alerts 
XL continually monitors incoming production data to identify instances where data quality can be 

improved. For example, if: 

▪ OEE Performance > 100%, then the ideal cycle time is likely too high/long. 

▪ 25% or more down events are missing reasons, then operators aren’t consistently scanning reasons.  

▪ Efficiency >= 110%, then the takt time is likely too high/long.  

We recommend reviewing data quality alerts at least once per week and taking action to correct any 

unresolved issues. To review data quality alerts: 

1. Log in as Administrator.  

2. Navigate to Settings > Management > Diagnostics.  

3. Click on the Data Quality Alerts Tab. 
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Simplify Down Reason Capture 
Down time is the largest source of lost production time for almost all manufacturers, so it’s 

understandable that most companies want to capture very detailed down time information. This often 

leads to complexity that ironically results in less accurate data. To start simple, we recommend: 

▪ Define no more than 15 down reasons, which will fit nicely on 1-2 barcode pages for the operator.    

▪ Set down thresholds for each part that are high enough that XL captures no more than 25 down 

events per shift (e.g., start with 3 minutes). Shorter down events will still be captured as small stops.   

Doing this will create actionable information without distracting operators from running their equipment. 

Once operators are accurately scanning a reason for each down event, cautiously consider lowering the 

down threshold and adding reasons.  

 

Capture Planned Stops 
It is important to differentiate between unplanned stops (Down) and planned stops (Changeover and 

Maintenance). All three are OEE Availability losses, but they have very different improvement strategies.    

We recommend creating Changeover and Maintenance reasons (Settings > Plant Floor > Reasons). 

Then, decide how you want to trigger each event and how counts should be handled during the event.  

▪ The End Event column sets how the event is ended. Choose by Barcode Scan, Definitely Running 

(Recommended), Target Time, and Target Time or Definitely Running. 

▪ If any have expected durations set a Default Target. This will enable the scoreboard to show 

operators the remaining time.  

▪ In the Counts column, configure to count inputs as usual, ignore counts, or automatically convert 

count inputs to reject inputs.  
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Capture Details with Comments 
Instantly add comments to any production event, such as a down event, changeover, or part run. Simply 

click on any chronogram event to add a comment. 

Use comments to add context to a reason, explain what went wrong, describe how you addressed a 

problem, or add to the conversation with a reply. Capture details that add value to review meetings or to 

deep analytics for improvement programs. 

 

Mine Comments for Insights 
Analyze comments to identify follow-up and improvement actions, or simply to verify that your team is 

following your policies for capturing comments. 

The Reports Menu > Improve > View Comments page is perfect for exploring comments. Select a 

built-in view or search for one or more words, such as OEE or conveyor jam. Gain further insights and 

context with single-click access to a complete loss report for each event. 

Alternatively, create your own views to focus on a specific type of event such as down or changeover 

events. Or look at all comments that occur during a period of time – such as a shift or part run. Add 

filters to refine your view. Create views that align to or verify company policy, such as: 

▪ Part Runs with OEE Below 65% 

▪ Down Events over 15 minutes with No Comments 
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Group Parts into Product Families 
If you have more than 50 SKUs for a manufacturing process, chances are that they can be grouped into 

logical families for the purposes of tracking them with XL. This makes it easier to configure XL and for 

operators to scan part barcodes. Simply create parts in XL named with their family name, making sure 

that all parts covered by a family share the same ideal cycle time and takt time. If you find you need 

more detail for a given family, you can expand it into individual part numbers.  

A more advanced option is for an XL integration partner to help you establish a direct connection 

between your ERP system and XL that will automatically transfer job and part parameters to XL during 

production. To learn more, refer to www.vorne.com/tools.  

 

Invest in Operator Training  
Deploying XL introduces change for operators. Typically, you will be asking operators to scan barcodes to 

start part runs and to capture down reasons. In return, the scoreboard will provide your operators with a 

much better sense for how well production is running and when to address and escalate emergent issues.  

There are two particularly important things you can do to help your operators: 

▪ Invest some time optimizing barcode pages (Settings > Plant Floor > Print Barcodes) to make it 

easier for operators to select and scan the correct barcodes.  

▪ Invest time in training. To help with training, we created the Operator’s Guide to XL as a 

PowerPoint® presentation that you can easily modify to best fit your application.  
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Navigation Overview 
XL includes a powerful web interface for reporting and configuration. This chapter highlights key features 

of the App Bar (dark grey), which appears at the top of every page and pertains to the entire 

application. The Page Bar (light grey) is specific to the current page. 

App Bar  
The App Bar contains buttons that enable you to access the home page, open menus or trigger actions, 

and toggle within the hierarchy. As you scroll through pages, the App Bar remains easily accessible.  

The Home Page button will return you to the page that has been set as the Device Default view by 

the Administrator.  This can be adjusted using the View Menu in the Page Bar. 

The Reports Menu houses all built-in reports and displays your Shared Dashboards.  It’s also 

home to XL’s learning content.  

 

The Enterprise Control displays the current level of the hierarchy for which you are viewing data 

as well as the higher Plant Level (if applicable). The bottom of the Enterprise Control menu will   

show you the Name of the Device you are connected to via IP address.  

 

 

 

 

 

 

 

 

The Reports Menu & Enterprise Control together help you easily navigate between your Reports & 
Devices. Browse Reports for the same set of devices or explore the devices & nodes in your 
Hierarchy for the same Report. 

TIP 
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Search is the quickest way to find detailed information about a metric. Type the metric name (or 

other term) and search will show you: current values of the metric (hour, part, and shift), pages 

whose title include the term you typed (with navigation links), terms whose definition include the 

term you typed. 

 
 

Notifications provide important information about data collection in XL. Alerts tell you the highest 

priorities but also tell you what happened and will recommend a next step.  

Data Quality Alerts notify you when XL identifies a potential problem with your data (e.g., an 

ideal cycle time that is set too high). 

Metric Alerts notify you when XL identifies an aspect of production that is not performing to your 

expectations (e.g., OEE < 70%). Metric alert thresholds are fully configurable (Settings > Metrics & 

Dimensions > Metric Alerts). 
 

   
 

 

Locale enables you to override the device locale (Settings > Device > Locale) with a locale that 

applies to just you (i.e., just your browser). Locale controls data formatting and language. 

 

 
 

The Log in provides access to log in as Administrator or Supervisor, enabling you to adapt XL to 

your application (as described in Configure XL).  
  

The Settings Menu is only accessible when logged in as Administrator or Supervisor, enables you 

to adapt XL to your application (as described in Configure XL). 
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Page Bar    
The Page Bar contains options that enable you to initiate actions that impact the view or page you are 

currently on. It primarily resides underneath the App Bar at the top of most pages and the selections can 

vary based on what page you are viewing and your user role.   

 

 

The View Menu has functions that support the ability to create, modify, and delete views. It also 

enables you to set various default views and control permission settings as an Administrator.  
  

    
  
   

Save options enable you to save the view in its current state or Save As to create a copy of your 

current view.  

    

Print button gives you the ability to print the current view by first taking you to a print preview 

page before sending to a printer.  

 

Help provides topics and videos for more information on the current page, which is the easiest and 

fastest way to master a given topic. 

 

Export lists all exportable (tabular) widgets on the page. Selecting any of the listed tables will 

generate an Excel® file with the data from that table. 

 

View Types consist of 3 main classifications of views primarily determining what views can be modified 

and how accessible the views are. These are found in most reports and all dashboards.  
 

Type Description 

Built-In Views that are shipped with the device. They cannot be modified or deleted to ensure that certain reports are 

always available. 

Shared Views that are created by an Administrator and made available to others. They are stored in the device. 

Local Views that are created by a user for personal use. They are stored in browser-based local storage, and as such 

can only be accessed from that computer and browser.  

Local views are deleted if you clear cookies and site data in the browser.  

 

 

The View and Save menus are best used in tandem.  They provide access to different views, allow 
users to create new or modify existing views, and have options to save or copy views.  

TIP 
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Overview 
Once you are collecting accurate data the next step is to leverage that data to drive improvement. This 

chapter presents proven ways to quickly leverage data from XL to drive action and improvement.  

Visualize Your Plant 
It is easy to create a beautiful real-time view of production for offices, meeting rooms, and the factory 

floor. A view that brings a strong focus on productivity to all levels of your company.  

Display the real-time Andon report on televisions or monitors using the standard XL browser interface. 

In the example below, we instantly see that Stamping Line 2 is stopped (red) and will likely miss their 

production target with only 91.2% Efficiency – time to help them get back on track.  

 

Escalate with Alerts 
The XL scoreboard lets your operators know when action is needed. But what about your support and 

management teams? Configure XL Enterprise to send your support and management teams alerts for 

specific conditions, such as a manufacturing process being down for an extended time. Use escalation to 

let the right people know at the right time when action is needed. 

Start by setting up a very small number of critical alerts. You can always add more later, but when you 

start you want to be very sure that anyone receiving alerts finds them to be extremely valuable.  

To learn more about configuring alerts, refer to the Configure XL guide. 
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Focus on Transitions 
Transitions in production, such as breaks, shifts, changeovers, and part runs often provide significant 

opportunities for improvement. The Reports Menu > Monitor > TPT page provides a visually 

impactful way to spot problematic transitions. Here are some key things to look for: 

▪ Breaks – Slivers of uncategorized down time (red) before or after breaks (blue). These often 

suggest extended break periods rather than verifiable (legitimate) down time issues. 

▪ Shifts – Similarly, slivers of down time (red) at the beginning and end of shifts.  

▪ Changeovers – Down time (red) immediately before changeovers (amber). This is often time that 

should be part of the changeover. XL automatically detects this and intelligently joins down events to 

changeovers (Settings > Metrics & Dimensions > Other Dimensions). 

▪ Part Runs – Patterns of down time (red) or poor running (light green) after starting new part runs 

and after changeovers. These patterns typically indicate opportunities to improve startups. 

 

Share Information 
Accurate and timely information is a powerful tool. Empower others on your team by sharing information 

with them. An easy way to do this is to have XL Enterprise send end-of-shift reports to key employees.  

 

If XL Enterprise has not yet been configured with an organization and linked XL devices refer to 
the Configure XL guide for instructions. 

NOTE 

 
Once you have linked XL devices: 

1. Login to XL Enterprise as an Admin and navigate to the All Users page. 

2. Create accounts for anyone that will benefit from end-of-shift reports.  

3. As new users receive their email invites and log in, all they need to do is select the work centers they 

want to monitor and opt in to end-of-shift reports (Email Report Subscriptions page) 
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Work on the Right Things 
It’s often difficult to know where to start. What should you focus on improving?  

The Reports Menu > Improve > Top Losses page is designed to make it much easier to answer this 

question. It ranks all losses from largest to smallest and includes detailed information for each loss.  

A simple and effective way to select your next improvement project is to focus on the largest loss where 

your team has ideas on actions they can take, minimal external resources are required, and actions can 

be taken straightaway. Then the real fun begins – taking action.  

 

Set Clear Targets 
People perform best when you establish clear expectations. Make it simple and fun for your operators by 

giving them an opportunity to “win the shift”. We recommend TAED on the scoreboard:  

▪ Target (target for good pieces; based on takt time; Settings > Plant Floor > Parts and Run States)  

▪ Actual (actual good pieces) 

▪ Efficiency (the ratio of actual to target) 

▪ Down Time (the largest OEE loss for most companies) 

An Efficiency of 100% or higher means your team is winning the shift. Many companies see an immediate 

improvement in productivity simply by setting a challenging but attainable target (via takt time) and 

showing operators status in real-time through the XL scoreboard. Learn more about setting takt times in 

the earlier Ideal Cycle Time vs. Takt Time section.  
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Appendix A: Metrics 
This appendix lists all the metrics that are generated by XL, along with their units of measure and 

descriptions. Some metrics are directly measured by XL, while others are derived through calculations. 

When metrics are derived the calculation is shown as part of the description.  

Metrics and dimensions are fundamental to how XL tracks production information. Metrics are numeric 

values that measure a quantitative characteristic of production, such as Good Count, OEE, or Labor 

Efficiency.  

Counts 
Core Counters 

Metric Units Description 

In Count Pieces Number of pieces that have entered the manufacturing process. 

Good Count Pieces Number of good pieces that have been manufactured. 

Reject Count Pieces Number of reject pieces that have been manufactured. 

End of Line Count Pieces Typically used to count product at the end of the line. Product might be pieces, boxes, or pallets.   

 

Additional Counters 

Metric Units Description 

Total Count Pieces Total number of pieces that have been manufactured. Calculated as Good Count + Reject Count. 

Startup Rejects Pieces Number of reject pieces that have been manufactured during and immediately after a 

changeover. 

Production Rejects Pieces Number of reject pieces that have been manufactured during steady-state production (after 
startup). Calculated as Reject Count - Startup Rejects. 

WIP Count Pieces Number of pieces between the In Count sensor and Good Count sensor. Calculated as In Count - 
Good Count.  

 

Count Percentages 

Metric Units Description 

Percent Good Percent Percentage of manufactured pieces that are good. Identical to Quality metric. Calculated as 

Good Count / Total Count. 

Percent Reject Percent Percent of manufactured pieces that are reject. Calculated as Reject Count / Total Count. 
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Cycles 
Number of Cycles 

Metric Units Description 

Run Cycles Cycles Number of “normal” cycles – cycles that are shorter than the small stop threshold. 

Small Stops Cycles Number of “longer” cycles – cycles that are longer than the small stop threshold. 

Partial Cycles Cycles Number of “boundary” cycles – cycles that are on the boundaries of run events. Each run 
event has one partial cycle. Whereas Run Cycles and Small Stops are measured from input to 
input, each partial cycle includes time from the start of the run event to the first input plus 
time from the last input to the end of the run event.  

Total Cycles Cycles Total number of cycles. Calculated as Run Cycles + Small Stops + Partial Cycles. 

Equipment Cycles Cycles Total number of cycles across ALL production states. All other cycle metrics are ONLY 
measured during run events. This metric is particularly useful for cycle-based work center care 

programs.  

 

Cycle Loss 

Metric Units Description 

Run Cycle Lost Time Seconds Time in excess of ICT for Run Cycles (waste). If this number is negative the ICT is set too 

high.  

Partial Cycle Lost Time Seconds Time in excess of ICT for Partial Cycles (waste).  

Cycle Lost Time Seconds Time in excess of ICT for Run Cycles and Partial Cycles (waste). One of the Six Big Losses. 

Calculated as Run Cycle Lost Time + Partial Cycle Lost Time. 

Small Stop Lost Time Seconds Time in excess of ICT for Small Stops (waste). One of the Six Big Losses. 

 

Cycle Times 

Metric Units Description 

Ideal Cycle Time Seconds Theoretical fastest possible time to complete one cycle for the currently running part. 
Configured on a part-by-part basis.  

Ideal Time Seconds Theoretical fastest possible time that it should have taken to complete all cycles. Used to 
calculate other metrics and not usually of direct interest to users. 

Current Cycle Time Seconds Time spent so far in the current cycle. Restarts at zero with every new cycle. 

Previous Cycle Time Seconds Time it took to complete the most recent cycle. 

Total Cycle Time Seconds Accumulated time for all cycles. Equals Run Time. Calculated as Ideal Time + Run Cycle Lost 
Time + Partial Cycle Lost Time + Small Stop Lost Time. 

 

Average Cycle Times 

Metric Units Description 

Avg. Cycle Time Seconds Average time for a cycle. Includes all cycles during run time. Calculated as Total Cycle Time / 

Total Cycles. 

Avg. Ideal Cycle Time Seconds Theoretical fastest possible time for one cycle as averaged across a time period. Calculated as 

Ideal Time / Total Cycles. 

Avg. Run Cycle Time Seconds Average time for each run cycle. Does not include small stops or partial cycles (i.e., it is 
analogous to the speed of your process when it is running). Calculated as Avg. Ideal Cycle 

Time + Run Cycle Lost Time / Run Cycles. 

Avg. Small Stop Time Seconds Average time for each small stop. Calculated as Avg. Ideal Cycle Time + Small Stop Lost Time 

/ Small Stops. 
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Labor  
Team Size 

Metric Units Description 

Current Team Size People Number of people currently working at the work center. Used to generate labor time metrics. 
Note that labor time is accumulated unless production is “not scheduled”. 

Team Size People Average number of people working at the work center. Calculated as Total Labor / Production 
Time. 

 

Labor per Piece 

Metric Units Description 

Current Target 
Labor per Piece 

Seconds Expected labor time to manufacture one good piece. Configured on a part-by-part basis. 

Target Labor per 
Piece 

Seconds Expected labor time to manufacture one good piece as averaged across a time period. Calculated 
as Earned Labor / Good Count. 

Labor per Good 

Piece 
Seconds Actual labor time to manufacture one good piece. Calculated as Total Labor / Good Count. 

Labor per Piece Seconds Actual labor time to manufacture one piece. Calculated as Total Labor / Total Count. 

 

Pieces per Labor Hour 

Metric Units Description 

Good Pieces per 
Labor Hour 

Pieces Good pieces manufactured per hour of labor time. Calculated as Good Count / Total Labor 
Hours. 

Pieces per Labor 

Hour 
Pieces Pieces manufactured per hour of labor time. Calculated as Total Count / Total Labor Hours. 

 

Labor Efficiency 

Metric Units Description 

Earned Labor Seconds Labor time “earned” by manufacturing good pieces. Each time a good piece is manufactured the 
Current Target Labor per Piece is added to Earned Labor. 

Lost Labor Seconds Labor time “lost” by taking longer than expected to manufacture good pieces. If this number is 
negative, pieces are taking less than the target labor time to manufacture. Calculated as Total 
Labor - Earned Labor. 

Total Labor 

Seconds 

The total of labor time on this work center. Note that labor time is accumulated unless 
production is “not scheduled”. 

The accumulated amount of labor time on this Work Center during Production Time. Each 
second of Production Time is multiplied by Current Team Size to generate this metric. Total 
Labor is comprised of two parts - Earned Labor (time “earned” by producing good pieces) and 
Lost Labor. 

Labor Efficiency Percent How actual labor time compares to the target, expressed as a percentage. This is the preferred 
metric for comparisons as it is normalized. In other words, 100% is meeting expectations and 

better than 100% is exceeding expectations. Calculated as Earned Labor / Total Labor. 

 

 

mailto:Support@vorne.com
https://www.vorne.com/support/technical-support/book-meeting/


Appendix A | Metrics  30 

Want Help? Support@vorne.com | 1.630.875.3600 | Book a Meeting 

OEE  
Core OEE 

Metric Units Description 

Availability Percent Percentage of planned production time where the process is running. 100% Availability means 
the process is always running during planned production time. Calculated as Run Time / 

Production Time. 

Performance Percent Percentage that compares the theoretical maximum speed (based on ideal cycle time) to the 
actual speed (based on accumulated run time). 100% Performance means when the process 
is running it is running as fast as possible. Calculated as Ideal Time / Run Time. 

Quality Percent Percentage of manufactured pieces that meet quality standards. 100% Quality means there 
are no rejects. Calculated as Good Count / Total Count. 

OEE Percent Percentage of planned production time that is fully productive. 100% OEE means perfect 
production (always running, as fast as possible, manufacturing only good pieces). Calculated 
as Availability × Performance × Quality. 

 

OEE Loss Percentages 

Metric Units Description 

Availability Loss Percent Percentage of planned production time lost to the process not running. Accounts for planned 
and unplanned stops. Calculated as 100% - Availability. 

Performance Loss Percent Percentage of planned production time lost to running slower than the theoretical maximum 
speed. Accounts for cycles longer than the ideal cycle time. Calculated as (100% - 

Performance) × Availability. 

Quality Loss Percent Percentage of planned production time lost to manufacturing pieces that do not meet quality 
standards. Accounts for defects (including parts that need rework). Calculated as (100% - 
Quality) × Availability × Performance. 

OEE Loss Percent Percentage of planned production time that is not productive. Calculated as 100% - OEE. 

 

OEE Lost Times 

Metric Units Description 

Availability Lost Time Seconds Planned production time lost to the process not running. Calculated as Availability Loss × 

Production Time. 

Performance Lost 
Time 

Seconds Planned production time lost to the process running slower than the theoretical maximum 
speed. Calculated as Performance Loss × Production Time. 

Quality Lost Time Seconds Planned production time lost to manufacturing pieces that do not meet quality standards. 
Calculated as Quality Loss × Production Time.  

OEE Lost Time Seconds Planned production time lost to all sources. Calculated as Production Time - Fully Productive 
Time. 

Fully Productive Time Seconds Represents perfect production (i.e., the time it would have taken to manufacture only good 

pieces as fast as possible). Calculated as Percent Good x Ideal Time. 

Planning 
Metric Units Description 

Goal Count Pieces Production goal for the current part run in terms of good pieces.   

Good Count Left Pieces Number of good pieces remaining to reach the production goal for the current part run. 

Calculated as Goal Count - Good Count. 

Percent Done Percent Progress towards production goal for the current part run. Calculated as Good Count / Goal 

Count. 
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Production Times  
Impact Times 

Metric Units Description 

Run Time Seconds Time the process has been in the run state (e.g., running). 

Down Time Seconds Time the process has been in the unplanned stop state (identical to Unplanned Stop Time 
metric). 

Planned Stop Time Seconds Time the process has been in the planned stop state (e.g., changeover). 

Not Scheduled Time Seconds Time the process has been in the not scheduled state (e.g., no production).  

  

Combined Times 

Metric Units Description 

Manufacturing Time Seconds Time the process is expected to be running. Calculated as Run Time + Down Time. 

Production Time Seconds Time the process is scheduled for production. Calculated as Manufacturing Time + Planned 
Stop Time. 

All Time Seconds Accounts for all time. Calculated as Production Time + Not Scheduled Time. 

 

Impact Percentages 

Metric Units Description 

Percent Run Percent Percentage of production time that the process has been running. Calculated as Run Time / 
Production Time. 

Percent Down Percent Percentage of production time that the process has been in an unplanned stop (identical to 

Percent Unplanned Stop metric). Calculated as Down Time / Production Time. 

Percent Planned Stop Percent Percentage of production time that the process has been in a planned stop. Calculated as 

Planned Stop Time / Production Time. 

 

Last Impact Event Times 

Metric Units Description 

Last Run Time Seconds Duration of the most recent (or current) run event. 

Last Down Time Seconds Duration of the most recent (or current) unplanned stop event (identical to Last Unplanned 
Stop Time metric). 

Last Planned Stop Time Seconds Duration of the most recent (or current) planned stop event. 

Last Not Scheduled 
Time 

Seconds Duration of the most recent (or current) not scheduled event. 

 

General Events 

Metric Units Description 

Duration Seconds Duration of a given event (e.g., a shift, part run, or production state). 

Start Time Date Time Date and time a given event started.    

End Time Date Time Date and time a given event ended. 
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Production State Events 

Metric Units Description 

Elapsed Time Seconds Time accumulated thus far in the current production state (e.g., changeover time).  

Target Time Seconds Expected time of the current production state (e.g., changeover target). 

Remaining Time Seconds Expected time until the current production state ends (e.g., remaining time for a 
changeover). Calculated as Target Time - Elapsed Time.   

Remaining Percent Percent Percentage of time expected to be remaining for the current production state (e.g., percent 
remaining for a changeover). Calculated as Remaining Time / Target Time.   

 

Mean/Quality Times 

Metric Units Description 

MTBF Seconds How long on average the process runs before it is stopped by a fault (Mean Time Between 
Failures). Calculated as Run Time / Down Events. 

MTTR Seconds How long on average it takes to get the process running once it is stopped by a fault (Mean 
Time to Repair). Calculated as Down Time / Down Events. 

 

Days 

Metric Units Description 

Calendar Day Days Identifies the calendar day of an event (calendar day changes at midnight). 

Production Day Days Identifies the production day of an event (production day changes on shift boundaries). 

Six Big Losses 
Six Big Losses Times 

Metric Units Description 

Down Lost Time Seconds Production time lost to down events (identical to Down Time and Unplanned Stop Lost Time 
metrics). 

Planned Stop Lost Time Seconds Production time lost to planned stop events (identical to the Planned Stop Time metric). 

Cycle Lost Time Seconds Production time lost to cycles longer than the ideal cycle time and shorter than the small 
stop threshold. Only time in excess of the ICT is considered lost. Calculated as Run Cycle 

Lost Time + Partial Cycle Lost Time. 

Small Stop Lost Time Seconds Production time lost to cycles equal to or longer than the small stop threshold. Only time in 

excess of the ICT is considered lost. 

Startup Reject Lost Time Seconds Production time lost to manufacturing rejects during startup. Calculated as Startup Reject 
Loss × Production Time. 

Production Reject Lost 
Time 

Seconds Production time lost manufacturing rejects during steady-state production. Calculated as 
Production Reject Loss × Production Time. 
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Six Big Losses Percentages 

Metric Units Description 

Down Loss Percent Percentage of production time lost to down events (identical to Unplanned Stop Loss 
metric). Calculated as Down Lost Time / Production Time. 

Planned Stop Loss Percent Percentage of production time lost to planned stop events. Calculated as Planned Stop Lost 

Time / Production Time. 

Cycle Loss Percent Percentage of production time lost to cycles longer than ideal cycle time and shorter than 
the small stop threshold. Only time in excess of the ICT is considered lost. Calculated as 
Cycle Lost Time / Production Time. 

Small Stop Loss Percent Percentage of production time lost to cycles equal to or longer than the small stop 
threshold. Only time in excess of the ICT is considered lost. Calculated as Small Stop Lost 

Time / Production Time. 

Startup Reject Loss Percent Percentage of production time lost manufacturing rejects during startup. Calculated as 
Startup Rejects / Total Count × Availability × Performance. 

Production Reject Loss Percent Percentage of production time lost manufacturing rejects during steady-state production. 
Calculated as Production Rejects / Total Count × Availability × Performance. 

 

Speed 
Metric Units Description 

Current In Speed PPH, PPM Speed parts are currently entering the manufacturing process. 

Current Good Speed PPH, PPM Speed good parts are currently being manufactured. 

Current Reject Speed PPH, PPM Speed reject parts are currently being manufactured. 

Current Total Speed PPH, PPM Speed parts are currently being manufactured. 

Current End of Line 
Speed 

PPH, PPM Current speed measured at the end of the line. 

In Speed PPH, PPM Speed that parts entered the manufacturing process, measured against Run Time.  
Calculated as In Count / Run Time x 60 (PPM) or In Count / Run Time x 3,600 (PPH). 

Good Speed PPH, PPM Speed that good parts were manufactured, measured against Run Time. Calculated as 

Good Count / Run Time x 60 (PPM) or Good Count / Run Time x 3,600 (PPH). 

Reject Speed PPH, PPM Speed that reject parts were manufactured, measured against Run Time. Calculated as 

Reject Count / Run Time x 60 (PPM) or Reject Count / Run Time x 3,600 (PPH). 

Total Speed PPH, PPM Speed that parts were manufactured, measured against Run Time. Calculated as (Good 
Count + Reject Count) / Run Time x 60 (PPM) or (Good Count + Reject Count) / Run Time 
x 3,600 (PPH). 

End of Line Speed PPH, PPM Speed at the end of the line, measured against Run Time. Calculated as End of Line Count / 

Run Time x 60 (PPM) or End of Line Count / Run Time x 3600 (PPH). 
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Rates 
Metric Units Description 

In Rate PPH, PPM Rate which parts entered the manufacturing process, measured against Manufacturing Time. 
Calculated as In Count / (Run Time + Down Time) x 60 (PPM) or In Count / (Run Time + 
Down Time) x 3,600 (PPH). 

Good Rate PPH, PPM Rate which good parts were manufactured, measured against Manufacturing Time. Calculated 
as Good Count / (Run Time + Down Time) x 60 (PPM) or Good Count / (Run Time + Down 

Time) x 3,600 (PPH). 

Reject Rate PPH, PPM Rate which reject parts were manufactured, measured against Manufacturing Time. Calculated 
as Reject Count / (Run Time + Down Time) x 60 (PPM) or Reject Count / (Run Time + Down 

Time) x 3,600 (PPH). 

Total Rate PPH, PPM Rate which parts were manufactured, measured against Manufacturing Time.  Calculated as 
(Good Count + Reject Count) / (Run Time + Down Time) x 60 (PPM) or (Good Count + Reject 
Count) / (Run Time + Down Time) x 3,600 (PPH). 

End of Line Rate PPH, PPM Rate at the end of line, measured against Manufacturing Time.  Calculated as End of Line 
Count / (Run Time + Down Time) x 60 (PPM) or End of Line Count / (Run Time + Down 

Time) x 3,600 (PPH). 

Target Rate  PPH, PPM Target Rate of the process during manufacturing (generated from Takt Time).  Calculated as 
Target Count / (Run Time + Down Time) x 60 (PPM) or Target Count / (Run Time + Down 
Time) x 3,600 (PPH). 

Rate Efficiency Percent Ratio of actual good parts to expected good parts (identical to Efficiency metric). 

Target 
Takt Time 

Metric Units Description 

Takt Time Seconds Expected pace of manufacturing for the currently running part. Set on a part-by-part basis (as 
a cycle time). Includes “budgeted” losses for down time, cycles, and rejects. Does NOT 
include time where production is not expected to be running (breaks, meetings, changeovers, 

and planned maintenance). Drives the target counter and efficiency calculations. 

Avg. Takt Time Seconds Average takt time across any time period. Calculated as Manufacturing Time / Target Cycles. 

Pace Timer Seconds Paces production by takt time. Each cycle the value starts at the takt time and counts down. 

 

Targets 

Metric Units Description 

Target Count Pieces Real-time target for good pieces. Each time the takt time elapses the target count increases. 
Often shown on the scoreboard together with good count to show operators where they are 
at as compared to expectations.  

Target Cycles Cycles Increments each time the takt time elapses. Used to calculate other metrics and not usually of 

direct interest to users. 

 

Efficiency and Variance 

Metric Units Description 

Efficiency Percent How production is doing as compared to expectations. 100% or higher means your team is 

“winning”. Calculated as Good Count / Target Count. 

Percent Variance Percent How far ahead or below expectations production is doing (as a percentage). Calculated as 

(Good Count - Target Count) / Target Count. 

Time Variance Seconds How far ahead or below expectations production is doing (in terms of time). Calculated as 
Percent Variance × Manufacturing Time. 

Count Variance Pieces How far ahead or below expectations production is doing (in terms of pieces). Calculated as 
Good Count - Target Count. 
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TEEP 
Core TEEP 

Metric Units Description 

TEEP Percent Percentage of ALL time that is truly productive. Often used for capacity planning. Calculated as 
OEE × Utilization. 

Utilization Percent Percentage of ALL time that is used for production. Calculated as Production Time / All Time. 

Schedule Loss Percent Percentage of ALL time that is NOT used for production. Calculated as 100% - Utilization. 

Production Loss Percent Percentage of ALL time that is taken up by lost production time (OEE Lost Time). Primarily used 
when presenting information from the perspective of all time (100%) being the sum of time not 
scheduled for production (Schedule Loss), time that is scheduled and productive (TEEP) and time 
that is scheduled and not productive (Production Loss). Can be calculated as OEE Lost Time / All 
Time OR 100% - Schedule Loss - TEEP. 

 

TEEP Lost Times 

Metric Units Description 

Schedule Lost Time Seconds Time lost to not being used for production. Calculated as Schedule Loss × All Time 

Production Lost 

Time 
Seconds Time lost to all sources of lost productivity during planned production time (this is simply another 

name for OEE Lost Time – a name which aligns with the Production Loss metric).  

Hidden Factory Time Seconds Untapped capacity of your manufacturing process. The maximum amount of additional 
production that can be unlocked without capital investment. Fully utilizing this time means 
around-the-clock perfect production – manufacturing only good pieces, as fast as possible, with 
no downtime, every hour of every day. Calculated as OEE Lost Time + Schedule Lost Time.  
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Appendix B: Dimensions 
Metrics & Dimensions are fundamental to how XL tracks production. Dimensions are descriptive values 

that refer to a qualitative attribute of production, such as the Shift, Work Center, or Hour. 

Aspects 
Dimension Description 

Impact Four mutually exclusive states that provide a top-level perspective of manufacturing: Run, Unplanned Stop, 

Planned Stop, and Not Scheduled. 

Job A work order identifier or other categorization that best identifies a specific part run. XL applies a dimension 

value of “Unknown Job” when production is detected but there is no job identifier. 

Part A part identifier for a specific part run. XL applies a dimension value of “Unknown Part” when production is 

detected but there is no part identifier. 

Production Phase Three mutually exclusive states that identify sequential phases of a part run: Changeover, Startup (time 
immediately following the changeover), and Steady State. These phases are important because they often 

have different loss characteristics.  

Production State A standardized and uniform way for XL to describe what is happening at the manufacturing process: Running, 
Running Slow, Running Poor Quality, Running Poorly, Down, Changeover, Maintenance, Meal/Break, Meeting, 
No Production, and Not Monitored.  

Reason A fully customizable way for you to describe what is happening at the manufacturing process from your 
perspective using terms that are familiar to your company. Reasons are particularly valuable for capturing 

information that will help you address losses and drive improvement. 

Reject Reasons A fully customizable way for you to describe the underlying reasons for quality loss. Reject reasons are 
particularly valuable for capturing information that will help you address losses and drive improvement. 

Shift A shift identifier. XL applies a dimension value of “Unknown Shift” when production is detected but no shift is 
scheduled.  

Ordinal Shift A dimension that orders shifts within a production day. This is especially useful for aligning shifts across work 
centers and time zones. 

Team An identifier for who is operating the process. Can refer to a single operator, a lead operator, or a crew. XL 

applies a dimension value of “Unknown Team” when production is detected but there is no team identifier.  

Assets 
Dimension Description 

Enterprise The entire organization. Metrics for all work centers monitored by XL are rolled up to the Enterprise.  

Site Manufacturing plants.  

Area Subdivisions within manufacturing plants. May be a physical area or a logical collection of work centers. 

Work Center The manufacturing processes being monitored.  

Time 
Dimension Description 

Hour Shift hours, which are relative to the beginning of the shift (e.g., Shift Hour 1, Shift Hour 2). 

Day Production days, which are aligned to shift boundaries to ensure that shifts that cross midnight stay within 

one day for reporting purposes. 

Week Production weeks, which always run from Monday to Sunday to provide consistency when aggregating 

information across multiple time zones and geographical areas. 

Month Calendar months (on production day boundaries).  

Quarter Calendar quarters (on production day boundaries).  

Year Calendar years (on production day boundaries). 
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Appendix C: Built-In Report Pages 

Advanced Analytics 
Dynamically explore data through an interactive set of KPI, chart and table widgets. Drag and drop 

dimensions to slice and dice your data in different ways. Ideal for deep data exploration across multiple 

dimensions and KPIs for a single manufacturing process.  

 

All Production 
View rolled-up real-time and historical production data for every Manufacturing Process, Area, and Site. 

Ideal for quickly viewing and comparing any portions of your manufacturing operation across any 

combinations of metrics. 
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Andon 
View the real-time status of every process with a colorful page suitable for display on a large format 

television or monitor. Ideal for communicating KPI’s in meeting rooms and offices to ensure that all 

personnel understand the current state of production. 

 

Changeover 
Deep dive into changeovers with instant analytics and answers to key questions. Ideal for gaining a 

better understanding of changeovers and how they compare across parts and part runs. 
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Down Time 
Deep dive into down time and its underlying reasons. Ideal for identifying which sources of down time 

are most important to address (e.g., emergent problems, problems related to specific parts, or by largest 

overall losses). 

 

OEE 
Deep dive into OEE and its underlying factors: availability, performance, and quality. Ideal for quantifying 

the major causes of lost productivity using OEE (a best practice metric) and identifying which OEE factor 

is most important to address.  
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Performance Loss 

Deep dive into performance loss and its underlying constituents: cycle loss and small stop loss. Ideal for 

identifying which parts and shifts are most affected by cycle losses, and for validating your ideal cycle 

time settings against actual production data.  

 

Quality Loss 
Deep dive into quality loss and its underlying constituents: startup rejects and production rejects. Ideal 

for identifying how each part is affected by quality losses and to better understand the underlying 

reasons. 
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Six Big Losses 
Deep dive into the six big losses: down time, planned stops, cycle loss, small stops, startup rejects, and 

production rejects. Ideal for gaining a deeper understanding of lost production time using a lean 

manufacturing framework that extends OEE into loss categories that each have a different set of 

countermeasures.  

 

Teams and Labor 
Deep dive into teams (an analytical dimension) and labor (metrics). Ideal for identifying best practices 

and creating standardized work that captures knowledge and transfers that knowledge between teams, 

as well as evaluating how actual labor efficiency compares to company standards.  
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TEEP (Hidden Factory) 
Deep dive into TEEP, which fully exposes your “hidden factory” by extending OEE with utilization and 

schedule loss. Ideal for identifying additional capacity that exists within your current manufacturing 

processes. Often evaluated as a precursor to new capital investments.    

 

Timeline 
View the state of multiple manufacturing processes over time on a synchronized timeline. Ideal for 

getting a quick picture of production in an area or site, and for finding patterns that exist across the site.  
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Top Losses 
View every loss that impacts OEE, ranked and prioritized by how much production time was lost, with 

additional details for each loss. Ideal for identifying, prioritizing, and evaluating the effectiveness of 

improvement projects. 
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Total Production Timeline  
View the state of the manufacturing process over time, including production state, shifts, production 

hours, and part runs. Ideal for spotting patterns and problematic transitions, such as rough running after 

a changeover.  

 

View Comments 
Analyze comments to identify follow-up and improvement actions – or simply to verify that your team is 

following your policies for capturing comments. Expand to show metric and reject details or add/remove 

metrics that are most important to your team. 
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Appendix D: Dashboards 

Dashboards 
XL includes a powerful engine for custom reporting via Dashboards.  Each Dashboard starts as a blank 

page, allowing you to add any of the following widget combinations and control the dashboard layout. All 

dashboard widgets are enterprise-aware, so every widget can include data from one or more Work 

Centers in your hierarchy. 

The View Menu hosts the functions for dashboards and some reports, including the ability to assign a 

view as the Page or Device default.  

Action Description 

Create new view Creates a new local view. Only available on dashboard pages. 

Share this view Converts a local view to a shared view so anyone can access it, deleting the local view.  You 
must be logged in to share a view. 

Modify name of 
view 

Allows you to change the name of the current view.   

Delete this view Deletes the current view. Not available for Built-In views 

Page default Sets the current view as the default view for this page (e.g. Dashboards or All Production). Only 
available for built-in and shared views, and when the view visibility is set to Anyone. 

Device default Sets the home page for the device (i.e., when the IP Address is entered). Only available for built-
in and shared views, and when the page and view visibility is set to Anyone. 

Access Control Restricts selected view or page. 

 

The Save Menu hosts the save and copy functions for dashboards.   

Action Description 

Save Saves the view in its current state. 

Save As Creates a copy of the current view as a local view with a new name. 

Create a Report 

 

1. Navigate to Reports Menu > Monitor > Dashboards 

2. Click View > + Create new view. 

3. Name your new Report. 

4. To make dashboard shareable, ensure you are logged in as Administrator, then navigate to View 

> Share this View and click OK to Share. 

5. If necessary, click the Layout control in the page control bar to change the dashboard from view 

mode to layout mode. 

6. Click + Add Widget and select from list. 
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Layout Mode 
Each dashboard can include any number of sections, and each section can be configured using any one 

of eight column layouts. Each column can hold any number of stacked widgets. 

 

Section Layout Controls: 

Control Description 

 Add Section Inserts a new blank section beneath the currently selected section. 

 Move Section Up Moves the currently selected section above the prior section. 

 Move Section Down Moves the currently selected section below the next section. 

 Delete Section Deletes the entire section.  

 Column Layouts Allows you to configure column layout within the section.  Choose from 

eight different options with up to six columns per section. 

Widget Layout Controls: 

Control Description 

 Add Widget Allows you to add a widget to the current section. 

 Delete Widget Removes widget from the current section. 

 Move Widget Allows you to move the widget within a section. 

 

Common Controls 
Below are controls consistently present in most widgets:  

Control Description 

Show Controls Allows you to show or hide controls while in either View Mode or Layout Mode. 

Enterprise Allows you to isolate or combine work centers within a widget 

Time Range Choose to follow the main page’s time selector or isolate your time range to a specific widget  

 Metrics Or Columns, typically contain quantitative metrics  

Dimensions Or Rows, typically contain qualitative values  

 Filters Restrict the underlying data by creating expressions for various Metrics and Dimensions 

 Duplicate Copy an existing widget in layout mode  
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Andon 
Andon widgets are beneficial for viewing up to four metrics in real-time or looking at historical data. You 

can show multiple Dimensions in the footer of the widget such as showing the current Job and Part.  

  

Chart 
Charts are useful for comparing, contrasting, and trending information for a visual audience. 

 
Chart Type: choose from cluster, column, heat map, line, Pareto, stacked column, and 

stacked Pareto. 

 Data Point: on time series data, the specific data value; for Pareto charts, the cumulative 

percentage 

 Trend Line: shown by default for time series data. 

 
Time Units: enables you to change the time granularity to Hour, Shift, Day, Week, Month, 
Quarter, or Year. 

The Chart widget includes a feature called Quick Charts that enables you to generate a chart by simply 

selecting metrics and dimensions in a way that resembles a chart title: 
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Chronogram 
Chronograms are useful for visually showing category values over time (e.g., whether the process is 

running or down). In addition to Common Controls, choose the edit icon to configure: 

 Add Strip: add data that will be visualized. 

  Strip Height: short or tall. 

  Heat Metric: metric that determines color of heat mapping. 

  Text Overlay: optionally show the dimension value and up to three metrics on chronogram events. 

  Labels: optionally show site/area/work center labels and legend. 

  Strip Placement:  Move Strip Up,  Move Strip Down, Delete Strip 

 

Event List 
Event Lists enable you to explore production information in a vertical timeline, where time is organized by 

whatever production- or time-based dimension you choose and search the comments associated with 

your events. In addition to Common Controls, you can configure:  

  Heat Metric: the metric that determines color of 

heat mapping. 

  Metrics: quantitative values in text overlay. 

 Event Body: detailed information below each 

heading. 

 

KPI and KPI Group 
KPIs provide detailed information about a single metric while KPI Groups show multiple metrics organized 

in tabular fashion. You can configure up to 30 metrics and formatting components with KPI Groups.  
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Table 
Tables show tabular information either grouped with drilldown or chronologically by event. In addition to 

Common Controls, you can configure:  

  Collapse to Level: show level of detail in rows 

 Sort: add sort rules of column dimension(s). You can add multiple sorting rules to tables. 

  Group: organize data by individual event, aggregated, or hierarchical. 

 Export: export to Microsoft Excel® (.xlsx format). 

 

Top Losses Table 
Top Losses allows you to see your top losses within a larger 

dashboard page.  In addition to Common Controls, you can 

configure:  

 Row Options: limit the number of rows visible. 

 Sort: add multiple sort rules (default by rank).  

 Export: export to Microsoft Excel® (.xlsx format). 

Pivot Table 
Pivot Tables summarize and cross-tabulate data across multiple dimensions, which makes it easier to see 

patterns in your data. You can configure: 

 Collapse to Level: show level of detail in rows 

  Row: qualitative dimensions in rows 

  Column: overarching category of quantitative data in table columns. 

  Metric: quantitative data in table columns. 

 Export: export to Microsoft Excel® (.xlsx format). 
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